
 

Excel 2013 Functions 

What is a function 
A function is a preset formula in Excel.  All functions begin with an equal sign ( = ) followed by the 
function's name and its arguments.  The arguments are contained inside round brackets. 

Functions can be entered into Excel by typing directly into a cell, typing into the formula bar, or by 
navigating to the Formulas bar. 

If you are entering a function into a cell or the formula, you must start the function with the = sign.  As 
you start typing the name of the function, Excel will give you options based on what you are typing.  If 
you navigate your mouse over the functions listed, you will see what that function will do for you.  To 
choose a function from the list, either use 
your arrows to highlight the function and hit 
the tab key, or double click on the function.  

 

On the Formulas bar, functions are separated into different categories.  If you are looking for a Text 
function, click on the Text icon.  If you aren’t sure which function you want to use, click on the Insert 
Function icon, this will allow you to search for a function based on what you would like it to do.  You can 
also see all of the categories by clicking on the category dropdown. 

 



When using the Insert Function icon, after you choose your function, Excel will step you through the 
arguments of the function within a window, versus in a cell or in the formula bar.  As you click into each 
text box, you will see a description of what each argument is looking for. 

Here is the VLOOKUP function as an example. 

 

Using Functions to Format Text 
In Excel, you can use a function to format text in a cell and copy the result to a range of cells.  In this 
example, we will use text formatting functions to Upper, Lower, Proper, and Trim. 

The syntax for these functions is very similar:  It is the function name followed by (text).   Where (text) is 
the text you want to convert.  It can refer to a cell or a string of text. 

Functions we will use: 
• =Upper(text): changed all characters into Upper Case 
• =Proper(text): Changed the first letter in a string of characters to Upper, while the remaining 

will be lower case 
• =Lower(text): changes all characters into Lower Case 
• =Trim(text):  removes all extra characters from a string of text.  Except for a single space 

between words 

Steps to Convert Text: 
1. Position the cursor in the cell to hold the formula 
2. Start typing in the function =Upper.  Either double click on the function name, or tab to enter 

into the function. 
3. Click on the cell containing the text you want to convert,  
4. Click Enter 

Tip: Use auto fill to copy the formula to other cells 
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Using the Substitute Function 
You can use the substitute function when you want to replace one character or set of characters with 
another set.   

The Syntax for Substitute 
=Substitute(text, old_text), new_text, instance_num) 

• Text:  The text that you want to make the substitution in 
• Old_text:  The letter(s) that you are replacing.  The letter must be in quotes.  Ex.  “a” 

o Note: These are case sensitive 
• New_text:  The new text that will be displayed 
• Instance_num:  The instance of the old_text within a string.  Is it the first instance of the letter 

“a”, is in the 3rd instance of the letter “a”? 
o Note:  The default instance number is 1.  If it is the 1st instance of a specific letter, you 

may leave instance_num blank. 

Steps to Convert Text 
1. Position the cursor in the cell to hold the formula 
2. Type the formula:   
3. The text in the cell is:  Mcmarshall, we need the text to read McMarshall 

4. The formula should read.   
a. We are looking in cell F6 for a lower case m.  We want to replace that lower case m with 

an upper case M on the first occurrence of that lower case m. 
5. The result of the formula should replace the lower case m to an upper case M resulting in 

McMarshall. 

Another Example: 

If the text should read “MacArthur” and it is displayed as Macarthur, 
then the formula would be: 

The instance is set to “2” meaning, ignore the first letter “a” and substitute the second “a” you see in 
the string of text. 

Concatenate   
Concatenation will join multiple strings of text into one.  Let’s say that City and State are set up in two 
different columns.  Our goal is to display the City and State together, in one cell. 

The Formula for Concatenate is =CONCATENATE(Text1, Text2, Text3, etc…)  

Note: You are able to put any text within the Text areas, but anything other than text from a cell, or a 
number, that you want to appear in the Text1, Text2, etc. must be in Quotes.  =Concatenate(A2,”, “,B2) 
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Position the cursor in the cell that will hold the data.  Type the following:   =con  
As you start typing, the formula smart tag will appear providing options to 
choose from.  When Concatenate is highlighted, press tab, or double click on 
concatenate.  Excel is now looking for the cell addresses that 
should be concatenated. 

With your mouse, click on the cell that contains the first piece of text, in this case the Cell containing the 
City, when you have the city, hit the comma key, the formula 
is now asking for text2 

For text2, we are looking for a comma and a space to separate the city and the state.  We are unable to 
get this from the spreadsheet, so we will have to type this into the text2 location.   

Remember, anything other text contained within a cell, or a number, must be typed inside of double 
quotes.  For the text2 location type in “, “ and then hit your comma key.  The reason the comma within 
the quotes doesn’t move us to text3 is because it is within quotes.  If we didn’t have quotes, we would 
have moved onto text3. 

Now the formula is looking for text3.  With your mouse, 
click on the cell containing the State.  Since this is the 
last piece, we can hit the enter key to finish our 
formula.  The resulting Formula should look like this;  

Copying and Pasting cells with Formulas 
When copying and pasting cells that contain a formula, Excel makes the assumption that you are 
wanting to copy the formula, and not the end result.  To paste the end result of a formula into a new 
location, you will have to use the Paste Special option. 

To do this, copy the cells that contain the formula which you want to paste in a new location.  Make the 
selection of the cells, and then use the keystroke Ctrl-C. 

Navigate to the new location, 
and either go to the Paste 
dropdown icon in the ribbon 
and select Paste Special.  On 
the Paste Special Window, 
select the Values and number 
formats radio button, and 
then click OK.  
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You may also perform this Paste by copying the data, right 
click in the location where you want to paste the data, and 
then select Paste Special.  You can use one of the Paste 
Special icons under Paste Values to paste your values in 
the new location.  With live preview, when you highlight 
over the Icons, excel will display how the data will be 
displayed.   

You may also select Paste Special on the bottom and pick 
your selection from the Paste Special Window.  

Flash Fill 
New to Office 2013 is a feature called Flash fill.  Flash fill will help you fill in empty cells within a 
spreadsheet based on patterns that already exist.  You may need to provide a couple of examples before 
Excel picks up on the pattern of what you are doing, but it typically works really well and will save you a 
lot of time.  In order for Flash Fill to work, you must stay within the same column, so you must hit Enter 
(or the down arrow) after you start typing your data to go to the cell below.  If you hit Tab or navigate 
into another row, Flash Fill will not work.  Flash fill is turned on by default and there isn’t any formula to 
remember, all you have to do is start typing. 
 
Flash fill can also be used to separate words from a single column into two separate columns.  If you 
have a First and Last name in the same column and you want them 
in two separate columns, go to the first blank cell and start typing 
the first name, hit enter and start typing the second first name.  
Flash Fill doesn’t always pick up on the pattern, so you may need to 
go to a third row in some instances.  When flash fill picks up the 
pattern, you will see a preview of the remaining cells contents.  If 
this is correct, hit Enter to fill in the remaining cells. 
 
Excel will fill in the remaining cells based on what it believes is the 
best pattern.  Depending on the type of 
data, this could be accurate and be what 
you are looking for.  When you use Flash Fill 
this way, you will have a Flash Fill options 
icon that appears to the right of the active 
cell.  Click on this icon and either Accept the 
Flash fill or undo the Flash Fill. 
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Combining Columns using Flash Fill 
In the first empty cell, let’s combine the city and the state into a 
single cell.  Hit Enter when you have finished.  Now in the second 
empty cell, start typing the city name, and Excel will see that 
pattern you are trying to duplicate.  Flash fill will give you a 
preview of what will happen to each corresponding cell.  If the 
pattern looks correct, hit the Enter or tab key and the column is 
filled in for you. 

If you do notice a mistake, you can always correct it by going into a single cell to make the necessary 
changes.  You can also undo the flash fill if you don’t want to use it by either clicking on the undo icon, 
or using the undo shortcut, Ctrl-Z. 

Another way to use flash fill is to type in the data you want in the first empty cell.  Hit enter to move to 
the next row.  Now navigate to the Data Tab and click on the Flash Fill icon. 

 

Note:  There are some instances where this will work, but this is not the best option when using Flash 
Fill because Excel may not be able to find a pattern.   
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Counting Formulas 
Excel has a couple different count Formulas that will give you various results based upon the data in the 
cells. 

=Count() 
The Count Formula will return the number of cells within a range that contain a Number.  If the range 
contains cells that have text, Excel will not include those cells in the Formula. 

=CountA() 
The CountA Formula will return the number of cells within a range that are not blank.  If will count both 
numbers and text. 

=CountBlank() 
The CountBlank Formula will return the number of cells within a range that are blank.  If there is a space 
in a cell, this is considered text and that cell will not be included in the Formula. 

CountIf, SumIf, AverageIf 
CountIf, SumIf, & AverageIf will perform Formulas only if certain criteria are met. 

For Example, if you are doing billing and you have multiple departments to bill to, you are able to 
separate out and add together only the hours billable to ACNS from an entire list of data. 

=CountIf() 
The CountIf Formula will count a range of cells that meet a certain criteria. 

The syntax is:  =CountIf(range,criteria) 
• Range:  The range of cells that contain the specific value, text string you are wanting. 
• Criteria: the specific number or text you are looking for.   

o Note: If this is text, it must be inside Quotes “ “.  Text is not case sensitive. 

=SumIf() 
The SumIf Formula will add the values within a range only if specific criteria are met. 

The syntax is: =SumIf(range, criteria, [sum_range]) 
• Range:  The range of cells that contain the specific value, text string you are wanting. 
• Criteria: the specific number or text you are looking for.   

o Note: If this is text, it must be inside Quotes “ “.  Text is not case sensitive. 
• Sum_Range:  This is the range of cells that you want to be added together if your criteria are 

met. 
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=AverageIf() 
The AverageIf Formula will average the values within a range only if specific criteria are met. 

The syntax is: =AverageIf(range, criteria, [average_range]) 
• Range:  The range of cells that contain the specific value, text string you are wanting. 
• Criteria: the specific number or text you are looking for.   

o Note: If this is text, it must be inside Quotes “ “.  Text is not case sensitive. 
• Average_Range:  This is the range of cells that you want to be added together if your criteria are 

met. 

Using the IF Formula 
The IF function tests to see if a certain condition in a spreadsheet cell is true or false. 
 
If the condition is true, the function will carry out a specific operation. If the condition is false, the 
function will carry out a different operation. 
 
=If(logical_test, value_if_ture, value_if_false) 

• Logical test:  Criteria you want the Formula to evaluate 
• Value_if_true:  The value to be returned if the condition is true.   

o This can be text (must be in parenthesis), a number, or a formula/function. 
• Value_if_false:  The value to be returned if the condition is False 

o This can be text (must be in parenthesis), a number, or a formula/function. 

Excel Comparison Operators 
Comparison Operator 

• = (equal sign) 
• > (greater than sign) 
• < (less than sign) 
• >= (greater than or equal to sign) 
• <= (less than or equal to sign) 
• <> (not equal to sign) 
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Example: 
If an order Total is Greater than $65, then there is free shipping, otherwise there is a $7 shipping charge. 

Steps: 

1. Place cursor in the cell where we are putting our If Statement. 
2. Navigate to the Formulas tab, and click on the Insert Function 

icon.  
3. Within the Insert Function window, search for If in the search 

textbox and hit the Go Button. 
4. Select the if function from the select a function box.  Select it by 

either double clicking on it or by selecting it and clicking the OK button 

 
5. In the Functions Argument window, we are able to see each argument of the if function.  For the 

logical test, we want to select the Cell that we are comparing.  In this case, we want to see if the 
Order total is greater than 65.  So, either type in the cell reference of B4, or navigate with your 
mouse and click on cell B4.  Now enter in the greater than sign > and 65. 

 
6. Value_if_true.  What do we want to happen if our order total is greater than $65.  We will offer 

free shipping so in this box, enter in a 0 
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7. Value_if_false.  What do we want to happen if our order total is less than $65.  The customer 
will be charged a rate of $7.  Enter in a 7. 

8. When we have all of our arguments filled out, click on the OK button and our function is now 
complete. 

9. To copy this function to the remaining cells, click back on 
the cell that contains the original function.  Move your 
mouse into the lower right corner until your mouse turns 
into a dark plus sign.   

10. Click and hold with your mouse as you drag to the bottom of the rest of the data.  You function 
has now been copied to all of the other cells. 

11. To complete our spreadsheet.  We will have to add an AutoSum into the Total w/shipping 
column. 

Relative versus Absolute Cell Addresses 
It is important to understand how Excel identifies cells in formulas.  By default, all cell references 
are relative references. As a formula is copied across multiple cells, they change based on the relative 
position of rows and columns. 
  
It is always best practice to use cell references in your formula if you can versus typing in static 
numbers/text into a function. 

Look at this sample of a Relative Reference.   
 
Excel reads the formula in cell C3 as “take the number located two cells to the left and add that to the 
number in the cell located one column to the left”.  Therefore, when you copy this formula (which 
appears as =A2+B2) to the cell below, it performs the calculation using the same pattern, but updates 
the formula to reflect the appropriate cell addresses.  This is called a Relative Reference and is the 
feature that enables you to copy the same formula to a different location in a worksheet. 
 
There will be times when you don’t want a formula to update, which is called an Absolute Reference.  
Unlike relative references, absolute references don’t change when copied or filled. You can use an 
absolute reference to keep a cell, a row or a column constant.   
 
For example, you might want to use a single cell to calculate the percent of sales by category.  Rather 
than doing a separate calculation for every employee, you could include a reference to that specific cell 
in the formula for each category.  This is called an Absolute Reference.   
 
To make a cell reference absolute so that it will not adjust when a formula is copied, insert a dollar sign 
($) in the appropriate position.  By navigating into the formula in the Formula bar, you can cycle through 
the references by hitting the F4 key on your keyboard. 
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 Press the F4 key one time 

 
    Two times 
     
    Three times  
  

 Example 1:  $B$12 Both the Row and the Column are held Constant 
 Example 2:  B$12 The Row is held constant, the Column will move 
 Example3:  $B12    The Column is constant, the Row will move. 

 

Example 2: Using Absolute cell referencing in an If Statement 
Create a formula in Total Sales for each record.  The formula should sum Qtr1-Qtr4 

• Position the cursor in the cell that will hold the formula. 
• We need to AutoSum the Total Sales column.  Use the AutoSum icon on the Home Tab. 
• Auto Fill the AutoSum function.   

o Position the cursor at the bottom right border of the cell 
that holds the formula, left-click the mouse, hold, and drag 
down the column for all records 

Tip:  To display a formula is a cell, press the shortcut keys ctrl ~ 

Once Total Sales has been calculated, then the IF statement can be applies to the Commission column. 

Steps: 
• Position the cursor in the cell that will hold the formula. 
• If total sales is > (greater) than $7000 (cell B4), then individual will receive a 2% (Cell B5) bonus 

of Total Sales.  If not, then no bonus 
• Start the formula with an = sign and type the 

IF Formula as follows: 
o =IF(F8>$B$4,F8*$B$5,0)  

• Use AutoFill to copy the formula for the rest 
of the column 

Tip:  To see the formula color coded to the cells that are used, press the F2 key while in the cell 
containing the Formula. 
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Using the OR & AND Formula 
Using the previous example, we can expand our worksheet to see if our employee completed training, 
should receive a yearend bonus, if they are above average, or if they should require further training.   

• OR Formula: only one of the conditions needs to be true to return a True Value 
• AND Formula:  all conditions need to be met to return a True Value 

Tip:  The OR, AND, Formula can be used alone.  However, nesting the OR, AND Formula within an IF 
statement is more useful. 

Steps for a nested IF(OR) Formula: 
• To receive a yearend bonus, the employee must either have completed the Training or received 

a commission.  If they meet 1 of these requirements, then will receive a 1.5% yearend bonus. 
• Position the cursor in the cell to hold the formula. 
• The formula will start with an = sign and use a combination of the If(or) statement.   

=IF(OR(H9="yes",G9>0),F9*$B$5,"No Bonus") 
• Use Auto fill to copy the formula for the rest of the columns 

Steps for nested IF(AND) Formula: 
In this example, we are trying to determine if the employee is “above average” with their sales.  When 
using the AND statement, all conditions must be true in order to return the value. 

If the employee completed training AND if total sales >$10,000, then the employee is considered “above 
average”. 

• Position the cursor in the cell to hold the formula 
• The formula will start with an = sign and use a combination of the IF(AND) statement.   
• =IF(AND(H9="yes",F9>$B$4),"Great Job", "") 
• Use Auto fill to copy the formula for the rest of the column
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Using Nested IF Statement 
Nested IF statements can evaluate multiple conditions.  In this example, we look at the total sales and 
determine what the commission should be for the employee. 

Scale for Commission 

 

Tip:  When you are working with a scale, you should have the scale in either increasing order, or 
decreasing order to help make your if statements easier to assemble.  If you scale is in Increasing order 
you will use the less than < sign in your arguments.  If your scale is in decreasing order, you will use the 
greater than > sign in your arguments. 

Steps for a Nested IT statement: 
• Position the cursor in the cell that will contain the formula. 
• The Formula must start with an =if then hit tab. 
• When you are working with nested if statements, you will see several parenthesis that will show 

you which if statement you are in.  You second, third, fourth, etc. if statement can be in either 
the Value_if_true, of the Value_if_false argument of the if statement. 

• Start our first if statement to compare the Total Sales to the smallest number on our 
commission scale 

o =if(F6<$L$3,$M$3, 
• If our argument is true, we will multiple the Total Sales by the commission in cell M3 

o Remember to use absolute references.   
• If this value is false, we want to start a new if statement, so after the comma in the 

Value_if_true argument, type if and hit tab to get into the new if statement. 

 
• The if will become all caps (IF), and your will now see the new arguments for the new If 

statement. 
• Continue this if statement comparing the Total Sales to the next number in the Scale, if that 

value is true, multiply by the associated Commission. 

 
• Since our scale only has 3 levels, we will only need 2 If statements.  The reason for this is if our 

sales are over $14,000, we don’t have to compare our sales to that number since anything over 
$14,000 will get 3%, even if we sell $100,000.  If our second if statement, if we don’t meet the 
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Value_if_true, that will mean we had sales of over $14,000, so in the Value_if_false argument, 
we can enter in the Total Sales by the 3% commission in cell M5. 

 
• When our formula is complete, you can either enter in all of the closed parenthesis that are 

needed, or you can simply hit the Enter key.  If you don’t have enough closed parenthesis, Excel 
will show an error and a correction.  Click the Yes button and Excel will enter in the missing 
closed parenthesis. 

 

Here is a color coded result of the formula. 

 

 

VLOOKUP  
The Vlookup function is a list of data in a worksheet that is used to populate data within another 
worksheet, workbook etc.  They are a basic form of a database.  The V stands for Vertical.  The Vlookup 
function searches for the left most column in a table array and returns the value in the same row, based 
on the index_number. 

For example, you need to translate a number grade into a letter grade.  The VLOOKUP Formula can help 
with this task.  
Creating a Lookup Table 
A lookup table includes the values you wish to "lookup" such as our Rating Code and the translation of 
the rating. You can place this table on the same worksheet, but for this Excel example, we'll add a 
worksheet called “codes” 
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How to Create a Lookup Table  
** Note:  I already created the worksheet with the codes and their translation.   

1. Right-click your spreadsheet’s tab and select Insert, Worksheet…  
2. Rename this new worksheet tab with a meaningful name such as “Letter Grade” 

**Note:  I already did this for you. 
3. In Column A, enter the unique values that exist on your main worksheet. In our example, these 

were the codes that showed in the Grade column in the image above. These values MUST BE IN 
ASCENDING order. 

4. In Column B, enter the translated value. You can have more values in column A than appear on 
your main spreadsheet.  
Note:  This doesn’t have to be in column B, it can be in any column after column A, but for 
simplicity, let’s use column B. 

 

 

 

 

 

Using the VLOOKUP Formula 
Excel’s VLOOKUP Formula uses 4 pieces of information. The Formula panel may seem intimidating with 
the terms, but it’s simpler than it looks. 

To lookup a value using VLOOKUP, 
• The new column on the original worksheet will display the info retrieved from the lookup table. 

In this example column J is where we will insert the Excel 
Formula. 

• Place your cursor in the first blank cell in the column. In our 
example, this is cell J2 

• From the Formula tab on the ribbon, select the Insert Formula 
icon.  The Insert Formula dialog will appear. 

• In the Search for a Formula: text box, type “vlookup” and click Go. 
• Highlight VLOOKUP and click OK 
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Defining the VLOOKUP Values 
After you click OK, Excel’s Formula Arguments dialog appears and allows you to define the four values. 
You’ll see that your starting cell and the formula bar show the beginning part of the Formula 
=VLOOKUP(). The Formula Arguments dialog adds the needed data elements that will display between 
(). 

For illustration purposes, I have overlaid the LetterGrade worksheet on top to show the relationships. 
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The Syntax for Vlookup formula 
=VLOOKUP(Lookup_value,Table_array,Col_index_num,Range_Lookup) 

• Lookup_value – This is the value that you are searching for in the Table_Array. 
• Table_array – This is a table with two or more columns.   

o There are several rules to remember about this table array. 
o Rule 1 - The left column must contain the values being referenced. In other words, the 

first column must equal a value associated with our Lookup_Value. 
o Rule 2 - You can’t have duplicate values in the leftmost column of the lookup range.  
o Rule 3 – This list must be sorted in ascending order based on the leftmost column. 
o Note:  When referencing a lookup table, you don’t want your cell references to change 

when you drag and fill to populate the other cells with the VLOOKUP Formula.  I need 
the cell references to be the same in all instances. After you define your range, you need 
to press F4 one time which will give you an absolute reference to this table array. Your 
table array should look similar to this 
LetterGrade!$A$2:$B$6 

Remember: Make sure you absolute reference your Table_array. 

• Col_index_num – This is the number of the column on your lookup table that has the 
information you want to return.  

• Range-lookup – This is an optional field.  The default value is TRUE.   
o If the value is TRUE(or blank), an approximate match is returned (if an exact match is not 

found, the next largest value that is less than the Lookup_Value is returned)   
o If the value is False, VLOOKUP will search for an exact match.  If VLOOKUP can’t find an 

exact match, the Formula returns #N/A. 
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Copying the VLOOKUP Formula to Other Cells 
It doesn’t make sense to use VLOOKUP for one cell in your Excel spreadsheet. Instead, you want to copy 
the Formula to other cells in the same column. 

To copy VLOOKUP to other column cells, 
1. Click the cell containing the VLOOKUP arguments. In our example, this would be J2. 
2. Grab the cell handle that displays in the lower right corner. 
3. Left-click and drag down the cell handle to cover your column range. 

Note: If we hadn’t changed to absolute reference as mentioned in Rule 3, we would’ve seen our table 
array entry shift by one cell as we dragged down through the other cells. 

VLOOKUP is a powerful Excel Formula that can leverage spreadsheet data from other sources. There are 
many ways you can benefit from this Formula. In this example, we simply used a 1:1 code translation. 
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